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Panduan Menggunakan Microsoft Project
A. Menjalankan Microsoft Project

Anda bisa menjalankan Microsoft Project dengan meng-klik ikon Microsoft
Project pada desktop atau dapat juga dengan meng-klik Start > All Pro-
grams > Microsoft Office > Microsoft Project
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Gambar |.Tampilan Awal Microsoft Project

B. Setting Awal Microsoft Project
Anda perlu melakukan sedikit perubahan setting tampilan untuk
mempermudah menggunakan Microsoft Project.

I. Mengganti Judul Kolom
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Gambar 2. Judul Kolom
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Double klik kolom Task Name dan akan muncul tampilan seperti berikut.
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Gambar 3. Column Definition

Pada baris Title ganti tulisan Task Name dengan Kegiatan, lalu klik Ok.
Lakukan hal yang sama untuk mengganti title yang lain Duration (Lama), Start
(Mulai), Finish (Selesai), Predecessors (Pendahulu), dan Resource Name
(Pelaksana).
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Gambar 4. Judul Kolom Setelah Diubah

Kolom yang ada terbatas sehingga perlu ditambah beberapa kolom lain
yaitu kolom Output dan Biaya. Kolom Output ditempatkan sebelum kolom
Lama dan kolom Biaya ditempatkan sebelum kolom Pelaksana.

Caranya dengan meng-klik kolom Lama, lalu pada menu pilih Insert >
Column atau tekan tombol Insert pada Keyboard. Kemudian akan muncul
tampilan seperti berikut.
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Gambar 5. Column Definition
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Pada baris Field Name, tulisan ID diganti dengan Text |. Caranya dengan
mengklik tombol panah disebelah kanan lalu cari Text |. Kemudian pada baris
Title diisi dengan Output. Klik Ok.

Lakukan hal yang sama untuk menyisipkan kolom Biaya. Klik kolom
Pelaksana. Kemudian pada Menu pilih Insert > Column atau tekan tombol
Insert pada Keyboard. Pada baris Field Name, tulisan ID diganti dengan Cost,
yaitu dengan meng-klik tombol panah disamping kanan lalu cari Cost. Pada
baris Title diisi dengan Biaya. Klik Ok

Apabila Anda melakukan langkah-langkah diatas maka Judul Kolom akan
tampak seperti berikut.
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Gambar 6. Judul Kolom Setelah Ditambahkan

2. Mengganti Simbol Mata Uang
Anda juga dapat mengganti simbol mata uang pada Microsoft Project.
Pada menu klik Tools > Options. Maka akan terlihat tampilan sebagai berikut.
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Gambar 7. Menu Options
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Pada baris Symbol, tulisan $ diganti dengan Rp kemudian pada baris
Decimal digit, tulisan 2 diganti dengan 0.

Setelah menyelesaikan langkah-langkah diatas maka Microsoft Project
siap digunakan.

C. Penggunaan Microsoft Project dalam Perencanaan

Pada panduan ini kita akan mengambil contoh sederhana dari perencanaan
kegiatan KONSULTASI JARAK JAUH OLEH KONSULTAN untuk diterapkan
dalam Microsoft Project.Agar mempermudah penyusunan kegiatan, maka dalam
memasukkan kegiatan memakai urutan dari yang paling akhir dilaksanakan
kemudian baru dilanjutkan pada kegiatan yang lebih awal.

I. Proses Memasukkan Data Kegiatan
Klik sel paling atas dari kolom Kegiatan, lalu isi dengan kegiatan yang
dianggap paling akhir. Dalam contoh ini kita akan menuliskan Konsultasi Jarak
Jauh Mulai Berlaku. Ingatlah untuk selalu menuliskan kegiatan dari yang paling
akhir karena hal ini akan mempermudah kita untuk menyusun perencanan
kegiatan. Langkah berikutnya adalah menuliskan kegiatan sebelum Konsultasi
Jarak Jauh Mulai Berlaku.

Selanjutnya kita akan menuliskan bahwa kegiatan Pengesahan Aturan
Main merupakan kegiatan sebelum Konsultasi Jarak Jauh Mulai Berlaku.

2. Cara Menyisipkan Kegiatan yang Lebih Dahulu
Klik sel Konsultasi Jarak Jauh Mulai Berlaku lalu tekan tombol Insert
pada Keyboard. Selanjutnya tersedia satu sel kosong. Tulislah dengan kegiatan
Pengesahan Aturan Main.

Kita akan menambah dengan beberapa kegiatan lagi yaitu Sosialisasi Draft,
dan Pertemuan Awal. Cara menyisipkan kegiatan sama seperti langkah diatas.
Apabila sesuai dengan langkah diatas maka akan terlihat seperti berikut.

Hegistan Ottt Lamsa
Pertemuan Lwwal 1 day?
Sosializasi Draft 1 day?
Pengesahan Aturan kMain 1 day?
Honsultasi Jarak Jauh huls 1 day?

Gambar 8. Memasukkan Data Kegiatan
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3. Memperbesar Ukuran Sel
Perhatikan bahwa tulisan Konsultasi Jarak Jauh Mulai Berlaku terpotong.
Untuk mengatasinya, blok semua tabel (caranya dengan mengklik sudut kiri
atas table hingga bentuk kursor berubah menjadi mata panah), klik kiri, tahan,
dan geser ke samping sampai tulisan tidak terpotong.

4. Mengisi Kolom Output, Lama, Mulai, Selesai, dan Pendahulu
Semua isian ditulis sesuai dengan jadwal yang telah anda tentukan.

Output

Pertemuan Awal: Ada Draft Aturan Main

Sosialisasi Draft: Peserta pertemuan awal mengetahui draft

Pengesahan Aturan Main: Ada peraturan mengenai mekanisme konsultasi

Konsultasi Jarak Jauh Mulai Berlaku: Ada peraturan mengenai mekanisme
konsultasi

Lama

Pertemuan Awal: 5 days atau cukup ditulis 5 d

Sosialisasi Draft:10 days atau cukup ditulis 10 d

Pengesahan Aturan Main: 2 days atau cukup menulis 2 d

Konsultasi Jarak Jauh Mulai Berlaku: 3 days atau cukup menulis 30 d
Mulai

Diisi sesuai dengan kesepakatan

Selesai

Kosongkan saja karena akan otomatis terisi

Pendahulu

Diisi dengan urutan dari atas ke bawah: baris paling atas kosongkan, baris
dibawahnya diisi I, kemudian baris dibawahnya diisi 2, kemudian 3, dan
seterusnya.
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5. Menuliskan Sumber Daya yang Digunakan pada Setiap
Kegiatan
Untuk menuliskan sumber daya yang akan digunakan pada setiap kegiatan,
Anda harus mengaktifkan terlebih dahulu Resource Sheet. Caranya masuk
ke menu View lalu pilih Resource Sheet.

Contoh.
Pada Pertemuan Awal kita memperkirakan akan menggunakan sumber daya
Orang: Arif, Rini, Adam, Kepala Puskesmas A, B, C, D, E

Benda: makan siang dan fotokopi

Pada Pengesahan Aturan Main kita memperkirakan akan menggunakan sumber
daya

Orang: Arif, Dini, Adam, Kepala Dinas

Benda: Fotokopi

Pada Konsultasi Jarak Jauh Mulai Berlaku kita memperkirakan akan
menggunakan sumber daya

Orang: Tim Puskesmas, Nara sumber

Benda: Pengadaan Telpon, Biaya pulsa

Kita akan menuliskan semua sumber daya ini pada kolom Resource Name.

Arif, Rini, Adam, Narasumber, Kepala Puskesmas A, B, C, D, E, Makan siang,
Fotokopi, Kepala Dinas, Tim Puskesmas, Pengadaaan Telpon, dan Biaya pulsa.
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6.Aturan dalam Mengedit Sumber Daya pada Resource Sheet

6.1. Untuk nama orang

Pada kolom Type dipilih Work. Biaya untuk orang (gaji) ditulis pada kolom
Std.Rate dengan perhitungan per hari sehingga ditulis Rp /d.

6.2. Untuk benda

Pada kolom Type dipilih Material. Biaya untuk benda ditulis pada kolom
Std.Rate dengan perhitungan harga per unit.

6.3.Accrue at

Pada kolom Accrue at dipilih Start.

Contoh.

|. Double klik sel Arif, kemudian Anda akan melihat menu dialog Resource
Information seperti gambar 9.
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Gambar 9. Menu Dialog Resource Information
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2. Selanjutnya pilih Tab General. Pada baris Type Anda dapat memilih Work
atau Material. Karena Kita sedang mengatur Resource Information untuk
Arif, maka pilih Work.

3. Pilih Tab Costs. Lalu ubah tulisan Rp0/h menjadi Rp50,000/d. Selanjutnya
ubah pilihan Cost Accrual menjadi Start.

Biaya masing-masing sumber daya bebas sesuai dengan perkiraan Anda. Langkah-
langkah yang dilakukan diatas akan terlihat dalam Resources Sheet seperti
tabel I.

7. Menuliskan Pelaksana
Pelaksana adalah semua sumber daya yang dipakai dalam satu kegiatan.
la dapat berupa manusia atau benda. Sumber daya tersebut diambil dari sumber
daya yang sudah kita kumpulkan pada contoh diatas.

Cara mengisi:

|. Double klik sel kosong pada kolom Pelaksana, lalu pilih Tab Resource
pada Menu Dialog Task Information.
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Gambar | 1. Menu Dialog Task Informatioan
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2.Perhatikan selalu di kegiatan mana Anda mengisi Pelaksana. Caranya dengan
melihat pada baris Name. Pada contoh ini kita mengatur Pertemuan Awal.
Klik Resource Name lalu cari cari nama orang atau benda yang digunakan
dalam kegiatan Pertemuan Awal. Cara mencarinya dengan meng-klik tombol
panah pada ujung kanan sel. Pemilihan sumber daya ini berdasar pada hal
yang sudah ditentukan sebelumnya pada point 5.

Contoh. Pada Pertemuan Awal
Nama orang: Arif, Rini, Adam, Narasumber, Kepala Puskesmas A, B, C, D, E
Benda: makan siang, fotokopi

Pada kolom Resources diisi dengan banyaknya unit. Pada orang perhitungannya
dengan persen sedangkan pada benda adalah jumlah barang yang digunakan,
misalnya:

- Arif, Rini, Adam bekerja sebanyak 50% dalam kegiatan

- Narasumber bekerja sebanyak 50% dalam kegiatan

- Kepala Puskesmas ABCDE bekerja sebanyak 50% dalam kegiatan
- Jumlah makan siang dalam 5 hari sebanyak 45 paket

- Junmlah fotokopi dalam 5 hari sebanyak 5 paket

Hasilnya dalam Resource Name akan terlihat gambar 12.
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Gambar |2. Resource Name untuk Pertemuan Awal

11



Panduan Menggunakan Microsoft Project
8. Memeriksa Detil Pembiayaan per Kegiatan
Anda dapat memeriksa detil pembiayaan per kegiatan dengan Task Us-
age. Untuk mengaktifkannya pilih menu View lalu klik Task Usage. Perhatikan
tampilan kolom Task Usage dibawah ini.
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Gambar 13.Task Usage

Klik pada judul kolom Duration kemudian tekan tombol Insert pada
Keyboard. Kita akan masuk ke menu dialog Column Definition. Pada baris
Field name masukkan Cost. Hasilnya akan terlihat seperti tampilan berikut.
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Gambar 14.Task Usage setelah Ditambahkan Kolom Cost
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9.Membuat Laporan Kegiatan (Budget Report)
Cara membuat laporan kegiatan (Budget Report) adalah sebagai berikut.
Pilih menu View, lalu klik Reports. Akan muncul tampilan seperti gambar 15.
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Gambar 15. Menu Report

Kemudian double klik Costs sehingga tampil gambar berikut.
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Gambar 16. Menu Cost Report

Selanjutnya double klik Budget pada menu Cost Report dan Anda akan
mendapatkan laporan kegiatan Anda.
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10. Mencetak Laporan kegiatan

Pada bagian akhir panduan ini kita akan belajar cara mencetak dokumen
hasil kerja Microsoft Project. Sebelum mencetak Anda harus terlebih dahulu
menentukan bagian mana yang akan dicetak.Anda dapat memilih melalui menu
View, lalu klik bagian yang ingin Anda lihat apakah Calendar, Gantt Chart,
Network Diagram,Task Usage, Tracking Gantt, Resource Graph, Resource Sheet,

atau Resource Usage.

Langkah selanjutnya untuk melihat hasil cetak, Anda bisa menggunakan
fasilitas Print Preview. Caranya dari menu File pilih Print Preview.
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Gambar 18. Print Preview

Dari window Print Preview ini Anda dapat memilih untuk langsung
mencetak dokumen dengan menekan tombol Print, atau mengatur kertas dengan
menekan tombol Page Setup... Selanjutnya untuk kembali ke lembar kerja
Anda dapat menekan tombol Close.
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D. Penutup

Sekian Panduan Singkat Menggunakan Microsoft Project. Bila Anda
menemui kesulitan atau memiliki pertanyaan seputar tulisan ini bisa
menghubungi:

Magister Kebijakan Manajemen dan Pelayanan Kesehatan
Fakultas Kedokteran Universitas Gadjah Mada

Gedung IKM It. 1 JI. Farmako, Sekip Utara, Jogjakarta

email: kmpk@ugm.ac.id website: www.kmpk.ugm.ac.id

Contact Person: Aditya LR (081802691481)
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